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Overview 
The Behavior Incident Report System (BIRS) provides early care and education programs and classrooms 
with a system to collect and analyze behavior incidents in their program. The system provides an 
efficient mechanism for gathering information on elements related to behavior incidents that can be 
used analytically to make decisions about providing supports to teachers and children within the 
program. Teachers within programs collect data on behavior incidents that are not developmentally 
normative or are a cause of concern to the teacher. These data are summarized monthly to provide 
formative data for examining factors related to behavior incidents (child, teacher, activity, behavior 
type, behavior motivation, and responses to the behavior). In addition, these data provide summative 
information on the frequency of behavior incidents over time and an analyses of potential equity issue 
by calculating disproportionality related to race, ethnicity, IEP status, gender, and dual language learner 
status. 

Getting Started 

Program Information 
Before you begin entering data, complete the demographics in the Program Information tab. This tab 
should be updated monthly.  

Enter the program name and school year.  

Next, enter classroom information. Enter the lead teacher’s name followed by the Classroom ID. 
Incidents will be identified by the Classroom ID, not a teacher ID. Enter the total number of students 
enrolled in the classroom by month. If a student withdraws from the classroom at any time, do not 
delete them from the count for that month. The totals across classrooms will automatically update as 
you enter the data for each classroom. 

For each month, enter enrollment by: 

• Ethnicity 
• Race 
• Gender 
• IEP status 
• DLL status 

Make sure your total for the month matches the classroom enrollment total. For Gender you only need 
to enter the total number of female students. The number of male students will automatically calculate 
based on the total enrollment for that month minus the total number of female students you entered. 
For IEP and DLL status, you only need to enter how many children have an IEP and are DLL. Excel will 
automatically calculate how many children do not have an IEP and are not DLL.  

Last, enter the number of school days per month. 
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These totals 
should all be 

the same. 

 

Child Enrollment 
A child must first be entered on the Child enrollment tab before a BIR can be entered. You do not need 
to enroll every child in the program. You should only enroll a child the first time a BIR is completed for 
him/her. Enter the child’s name, unique child ID (which will be used on any subsequent BIR forms), 
gender, DLL status, IEP status (yes, they have an IEP or no, they do not), ethnicity, race, and enrollment 
status. You can also add notes about the child if you wish (i.e., date of first enrollment, classroom 
switches, disenrollment date, etc.).  If a child switches classroom, they do not need to be enrolled again. 
Also, if a child is Hispanic or Latino, you do not need to enter their race. For BIR calculation purposes, 
Hispanic or Latino children of any race are only counted by their ethnicity; they are not counted by their 
race. In other words, a Hispanic or Latino child who identifies as Black or African American will only 
count as being Hispanic or Latino of any race, they will not count towards the total number of Black or 
African American children. 

Please note: If you have more than 175 unique children with behavior incidents, please email 
veguilla@usf.edu as the file will need to be adjusted to accommodate more children. 

mailto:veguilla@usf.edu
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Data 
The Data tab is your main data entry tab for recording behavior incidents. Once a classroom is enrolled 
and a child is enrolled, you can begin to enter incidents. Each row represents a unique incident in the 
classroom.  
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In the dropdown for Classroom ID, select the ID for the classroom. You may need to scroll up to find the 
ID. Do the same for the Child ID.  

If you cannot find the ID for the classroom or the child, refer to the Program Information tab to make 
sure the teacher has been enrolled and that the right classroom ID has been recorded on the paper form. 
If you cannot find the child ID, refer to the Child Enrollment tab to make sure the child has been enrolled 
and that the right child ID has been recorded on the paper form.  

Select the month the incident occurred by looking at the date on the BIR form. Next, enter the date in 
m/d/yy format. Enter the time the incident occurred. The time should be entered in 24-hour format; 
however, you can enter the time in 12 hour format and enter AM or PM after the time. For example, if it 
is “10:20 AM”, you can simply enter “10:20.” If it is “1:30 PM”, you can either enter “13:30” or “1:30 
PM.” Entering “10:20AM” without a space in between the time and the time period will result in 
incorrect data. 

Next, select the most intrusive problem behavior, the activity, and others involved. If there is more than 
one person involved, the form should indicate which person was directly affected by the student’s 
behavior, not who was merely present. Select the possible motivation, the response, and the 
administrative follow-up (if any).  

Do not leave cells blank. Each category has either a “Don’t Know,” “None,” or “Not Applicable” option 
you can select. Leaving cells blank results in incorrect data.  

At the end of the record, you may enter notes if you wish. 

TIP: if you have many BIRs to enter, you may consider turning off automatic calculation until you are 
done with data entry. To do this, go to the Formulas tab, Calculation Options (small calculator) and 
select Manual. When you are done with entry, do the same but select Automatic. 

 

 

 

Program Summary 
The Program Summary tab provides an overview of the behavior incidents in the program as well as any 
alerts regarding disproportionality.  
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You do not need to input anything into this tab. However, before looking at data, the user should update 
the charts. To update your charts, go to the Data tab on the Excel ribbon and select Refresh All.  

Alternatively, you can scroll down to the Percent of BIRS to Date by Problem Behavior chart on this tab. 
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Click on the chart and a new tab will appear on the ribbon. This tab is called “PIVOT CHART TOOLS.”  

 

 

Select “ANALYZE.”  

 

 

Select “Refresh.” Select “Refresh All.” 

 

 

Please note that it may take a few minutes for all of the charts to update. Scroll down to see the remaining 
At-A-Glance charts. 
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Equity Profile Alerts 
If there is any possible disproportionality requiring further analyses, a statement alerting the user will be 
displayed under the Equity Profile Alerts heading. Click on the alert to go to the tab that will give you 
more information regarding the alert. Please note: the color of the alert does not have a meaning. It is 
simply a hyperlink blue or might be color red. 
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Quick Links 
Quick links are located to the right of the Equity Alerts. These links will take you to different tabs in the 
workbook. You can click on any of these links to quickly get to that tab.  

 

Monthly BIRs by Classroom ID 
On this tab you will have the option of looking at the total number of incidents by classroom ID. On the 
left-hand side there are 2 options for filtering data. You can filter by Classroom ID, by Month, or by both.  
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To select a classroom, click on the classroom ID. If you wish to select more than one classroom, hold 
down the Ctrl key on your keyboard and click on the other ID or IDs to also select. If you clicked on the 
incorrect ID, click on the ID again. If you would like to remove all of your filters to show all, click on the 
filter icon at the top of the selection window. 

 

Alternatively, you can also click on the icon next to the filter icon and then select and deselect your 
options. 

If your chart shows “(blank)” as a Classroom ID option, you can remove this by going to the down arrow 
at the top of your chart by the Classroom ID and unchecking the box labeled “(blank).” After you 
uncheck, click OK. 
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As you filter by Classroom ID the ability to filter by month updates. The Month filter will update based 
on availability of data based on the Classroom ID option(s) you select. Only months for which there are 
data will be available for further selection. 

 

 

If you filter by month first, the classroom IDs that do not have data in that particular month will be a 
lighter color blue. You will be unable to select these.   
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Problem Behavior 
The Problem Behavior tab includes several tables and graphs about problem behavior. The table at the 
top has the number of incidents by month by problem behavior. The bar chart below it represents the 
percentage of incidents by problem behavior by month. You are able to filter the table and chart by 
problem behavior(s).  

 

Below is a chart showing the number and percent of incidents by problem behavior. The percent of 
incidents is graphed in a pie chart. You are able to filter by classroom ID, month, ethnicity, race, gender, 
DLL and IEP status. 
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Activity, Others Involved, Possible Motivation, Response, 
Admin Follow Up 
The following tabs have the same set up. These tabs include several tables and graphs about the specific 
category of interest (as represented by the tab name). The table at the top has the number or incidents 
by month by item for that specific category. The bar chart below it depicts the percentage of incidents 
by item by month. Below that is a table showing the number and percent of incidents by item for that 
specific category. The percent of incidents are graphed in a pie chart and a bar chart (both provide the 
same information). The light green table shows the number and percent of incidents by item by problem 
behavior. You can filter by classroom ID, month, ethnicity, race, gender, DLL and IEP status.   

Total # of Incidents Month
Activity (blank) September October November December January February March April
(blank)
Circle/Large group activity 3 19 11 4 8 11 12 17
Departure 1 2 2 1 5 4
Centers/Indoor play 3 26 11 5 14 18 23 31
Self-care/Bathroom 2 1 1 3 3
Transition 10 7 7 4 5 8 6 5
Quiet time/Nap 5 19 2 3 3 9 15 7
Clean-up 1 4 2 2 3 1 2 2
Small group activity 5 2 4 5 5 3 9
Outdoor play 2 6 5 6 1 4 2 15
Arrival 10 6 3 8 4 2
Transportation
Other 1 2 6 6 5
Meals 7 5 2 1 11 4 5
Individual activity 1
Total 27 105 52 38 53 78 81 102

Classroom ID (All) Classroom ID (All)
Month (All) Month (All)

Values Values
Activity % of Total Incidents Total # of Incidents Activity_Problem Behavior % of Total Incidents Total # of Incidents
Centers/Indoor play 26.59% 192 Centers/Indoor play 26.59% 192
Circle/Large group activity 13.16% 95 (blank) 0.00% 0
Transition 11.22% 81 Physical aggression 9.42% 68
Quiet time/Nap 10.11% 73 Non-compliance 3.74% 27
Outdoor play 8.73% 63 Disruption/Tantrums 1.80% 13
Small group activity 6.93% 50 Running away 0.14% 1
Meals 6.37% 46 Inconsolable crying 2.08% 15
Arrival 5.96% 43 Unsafe behaviors 5.40% 39
Clean-up 3.88% 28 Other 0.55% 4
Other 2.77% 20 Social withdrawal/Isolation 0.28% 2
Departure 2.22% 16 Inappropriate language 0.97% 7
Self-care/Bathroom 1.80% 13 Verbal aggression 0.28% 2

Individual activity 0.14% 1
Breaking/Destroying objects 
or items

1.80% 13

Transportation 0.14% 1 Hurting self 0.14% 1
(blank) 0.00% 0 Trouble falling asleep 0.00% 0
Total 100.00% 722 Circle/Large group activity 13.16% 95

(blank) 0.00% 0
Physical aggression 2.91% 21
Non-compliance 3.88% 28
Disruption/Tantrums 1.94% 14
Running away 0.14% 1
Inconsolable crying 0.83% 6
Unsafe behaviors 1.66% 12
Other 0.55% 4
Social withdrawal/Isolation 0.00% 0
Inappropriate language 0.28% 2
Verbal aggression 0.28% 2
Breaking/Destroying objects 
or items

0.69% 5

Hurting self 0.00% 0
Trouble falling asleep 0.00% 0
Transition 11.22% 81
(blank) 0.00% 0
Physical aggression 3.05% 22
Non-compliance 2.49% 18
Disruption/Tantrums 1.94% 14
Running away 0.42% 3
Inconsolable crying 0.55% 4
Unsafe behaviors 1.52% 11
Other 0.55% 4
Social withdrawal/Isolation 0.00% 0
Inappropriate language 0.28% 2
Verbal aggression 0.28% 2
Breaking/Destroying objects 
or items

0.14% 1

Hurting self 0.00% 0
Trouble falling asleep 0.00% 0
Quiet time/Nap 10.11% 73
(blank) 0.00% 0
Physical aggression 2.08% 15
Non-compliance 3.46% 25
Disruption/Tantrums 1.11% 8
Running away 0.55% 4
Inconsolable crying 0.55% 4
Unsafe behaviors 1.66% 12
Other 0.28% 2
Social withdrawal/Isolation 0.00% 0
Inappropriate language 0.28% 2
Verbal aggression 0.00% 0
Breaking/Destroying objects 
or items

0.00% 0

Hurting self 0.00% 0
Trouble falling asleep 0.14% 1
Outdoor play 8.73% 63
(blank) 0.00% 0
Physical aggression 3.46% 25
Non-compliance 2.22% 16
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Classroom Summary 
The Classroom Summary tab allows you to filter data by classroom ID. Once you select an ID, the tables 
and graphs on the tab will display data for that classroom only. The table below the Classroom ID filters 
shows the IDs of the children in that specific classroom that have BIRs and the number of BIRs for each.  

 

Child Summary 
The Child Summary tab allows you to filter data by child ID. Once you select an ID, the tables and graphs 
on the tab will display data for that child ID only. The filter below the Child ID filter identifies which 
classroom ID is associated with the Child ID selected by highlighting a darker gray then the other IDs. 
Below that filter is a table that shows you the demographic information for the selected child.  
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Distribution by Classroom ID 
This tab provides a location for filtering data by any of the categories to provide a table of classroom and 
child IDs and total number of incidents. You can filter by any of the categories. As you select an item in a 
category, the other categories will filter out automatically to allow for further filtering. You can select 
more than one item by using Ctrl on your keyboard and clicking on the option. To clear filters, clear the 
first category you selected. The filter icon will be dark gray and red in comparison to the other filters.  

 

 

To hide child IDs and only view classroom IDs, click on the box next the classroom ID.  

 
  



Behavior Incident Report System (BIRS) Data Entry Guide 

Page | 17  
 

Equity Profiles 
The equity profiles do not require any data entry or selection of filters/values. These tabs will auto 
populate based on data entry. However, program demographics by race/ethnicity, gender, DLL and IEP 
status must be entered on the Program Enrollment tab as well as for each child on the Child Enrollment 
tab. If you do not enter these data, these tabs will not function properly.  

If there is a value that needs further analysis, it will be highlighted red under the Child Composition 
column and/or highlighted yellow under the Risk Ratio column. Please note, the use of color red and 
yellow are arbitrary, they do not have any special significance other than to serve as an alert to the user.  

 

 

If you scroll below the statements, bar charts accompany each equity profile. The first bar chart shows 
behavior incidents by each category (total enrollment, number of students with an incident, and total 
number of BIRs). The next chart shows the risk ratio for each category. 
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Risk Of the 20 children identified as being of Two or more races, 0% have at least one BIR.

Child Comp. Of the 38 children who received at least one BIR, 21.1% are White; this group comprises 24.6% of the total child enrollment.
BIR Ratio The average number of BIRs per child for White children is 2.15 times the BIR Rate for all other children.
BIR Rate Children identified as White receive an average of 4.38 BIRs per child.

Risk Ratio White children are 0.82 times more likely to have at least one BIR than all other children.
Diff. in C Comp. White children's representation among children who receive BIRs is 3.6 percentage points lower than expected given White children's percentage of the child enrollment.
Diff. in R Comp. The percentage of BIRs attributed to White children is 16.7 percentage points higher than expected given White children's percentage of the child enrollment.

BIR Comp. Of the 721 BIRs generated, 41.3% were attributed to White children.
Risk Of the 68 White children, 11.8% have at least one BIR.
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Child ID by ISS_OSS_DIS 
This tab is used to identify children with an in-school suspension, out-of-school suspension, and/or 
dismissal. In these filters, the number 0 means no and the number 1 means yes. If you want to filter 
children that have an ISS, you select the number 1 from the ISS filter. The table will then update showing 
you the Child ID(s) associated with an ISS. The same is true for OSS and Dismissal (labeled Expulsion). 
You can also filter by demographic variables.  
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Additional Resources  
NCPMI has developed additional BIRS resources that can be accessed via our website.  

• To download the BIR System, BIRS Data-Based Decision-Making Guide, BIR form, and 
instructions and operational definitions to items on the BIR form visit:  
https://challengingbehavior.cbcs.usf.edu/Implementation/data/BIRS.html  
 

• Using the Behavior Incident Report System: Frequently Asked Questions:  
https://challengingbehavior.cbcs.usf.edu/docs/BIR_FAQ.pdf 
 

• The Behavior Incident Report System (BIRS):  
https://challengingbehavior.cbcs.usf.edu/docs/BIR_Overview_Factsheet.pdf 
 

• Behavior Incident Report System Readiness Checklist: 
https://challengingbehavior.cbcs.usf.edu/docs/BIR_readiness_checklist.pdf  

https://challengingbehavior.cbcs.usf.edu/Implementation/data/BIRS.html
https://challengingbehavior.cbcs.usf.edu/docs/BIR_FAQ.pdf
https://challengingbehavior.cbcs.usf.edu/docs/BIR_Overview_Factsheet.pdf
https://challengingbehavior.cbcs.usf.edu/docs/BIR_readiness_checklist.pdf
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